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Getting Started with 
PowerPoint Basics

Discover PowerPoint 
basics such as starting a 
presentation and navigating 
through PowerPoint. In 
this chapter, you learn the 
various elements of the 
PowerPoint screen, and 
how to get help when you 
need it.

03_577660-ch01.indd   203_577660-ch01.indd   2 5/3/10   7:58 PM5/3/10   7:58 PM

CO
PYRIG

HTED
 M

ATERIA
L



Introducing PowerPoint ..................................... 4

Start and Exit PowerPoint ................................. 6

Explore the Normal View ................................... 8

Navigate PowerPoint Views .............................. 9

Work with the Ribbon Groups, 
Commands, and Galleries ...........................10

Hide the Ribbon Commands ...........................12

Find and Use KeyTips .......................................13

Using the Quick Access Toolbar .....................14

Resize the Notes Pane ......................................15

Using Help ...........................................................16

03_577660-ch01.indd   303_577660-ch01.indd   3 5/3/10   7:58 PM5/3/10   7:58 PM



4

The PowerPoint program provides various views and tools you can use to build a presentation 
that includes words, graphics, and media. PowerPoint enables you to accomplish the 
following tasks to design and build a presentation.

Introducing 
PowerPoint

PowerPoint Your Career

in

Art

Your C
areer

in

Art

Your Career
in

Art

Add Content
You can add content such as text, charts, and pictures 
to the slide itself in the Slide pane of Normal view. 
You also can insert text boxes that enable you to add 
slide text that does not appear in the presentation 
outline.

Choose a Slide Design and Layout
The slide design applies preset design elements such 
as colors, background graphics, and text styles to a 
slide. The slide layout you apply to a slide determines 
what set of information the slide includes. For example, 
a Title and Content layout includes a placeholder for a 
title, plus a placeholder that holds a bulleted list or 
graphic element. A Title Slide layout has title and 
subtitle placeholders.

Build an Outline
You can use the Outline tab to type the text for your 
presentation. On the Outline tab, an icon represents 
each slide, and each slide contains a slide title next to 
the icon. Many slides contain second level text that 
represents slide bullet points. These bullets convey 
the main points you want to make about each topic.

Work with Masters
Masters enable you to add content that you want to 
appear in a particular location on every (or almost 
every) slide. This saves you from having to add 
repetitive content, such as your company logo, to 
each slide. For example, you can set up the master 
so an identical footer appears on every slide.
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Font and Size 
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Show Judges
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Set Up Your Show
You can add narrations, animations, and transitions 
to your slides. You can record a narration that plays 
when you give your presentation; use animations to 
move an element on-screen, such as a graphic flying 
onto the screen; and use a transition to control how a 
new slide appears on-screen; for example, the slide 
can wipe in from the corner of the screen.

Organize Slides
After creating several slides, you may need to 
reorganize them to create the proper sequence for 
your presentation. You can reorder slides in the Slide 
Sorter view. This view shows slide thumbnails that 
you can move, delete, duplicate, or hide. You can 
also accomplish these actions on the Slides tab of 
Normal view.

Format Text
After you enter the text for your presentation, you can 
format that text in various ways. You can change the 
font, increase the font size, and apply bold or italics to 
the text. Note that you can modify each individual text 
selection or apply text styles globally using masters.

Run a Slide Show
After you add the content, choose the slide design 
and layout, and add special effects, you are ready to 
run your slide show. A set of tools that appears 
on-screen during the slide show helps you control 
your presentation and even enables you to make 
annotations on your slides as you present them.
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3 Click Microsoft Office.

4 Click Microsoft PowerPoint 
2010.

Note: If you purchased PowerPoint as a stand-
alone product, simply click All Programs, and 
then click Microsoft PowerPoint 2010.

1 Click Start ( ).

2 Click All Programs.

Start and Exit PowerPoint

You can start PowerPoint from the Windows 
Start menu. When you open PowerPoint, a 
blank presentation appears automatically. The 
blank presentation is ready for you to add your 
presentation contents.

Start and Exit 
PowerPoint
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Is there a quicker way to open PowerPoint?
Yes. You can place a shortcut to PowerPoint on your Desktop.

1 Repeat Steps 1 to 3 in this section.

2 Right-click Microsoft PowerPoint 2010.

3 Click Send to.

4 Click Desktop (create shortcut).

 The Microsoft PowerPoint 2010 shortcut icon appears.

6 Click Exit.

 The program closes and the 
Windows desktop reappears.

 A new PowerPoint presentation 
appears with a blank slide.

5 To exit PowerPoint, click the 
File tab.
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Outline Tab
This tab enables you 
to enter text into 
your slides in a 
familiar outline 
format. Top-level 
headings in the 
outline are slide 
titles; entries at the 
second level appear 
as bullet points.

Slides Tab
The Slides tab contains thumbnails of each slide — they are numbered by the order 
that they appear in the slide show. You can drag the thumbnails to change the 
order of slides.

Slide Pane
The Slide pane is 
the largest pane in 
Normal view and 
shows a slide and all 
its contents. Here 
you can create and 
manipulate slide 
objects such as 
graphics, text, and 
animations.

PowerPoint offers several views you can display to work on different aspects of your 
presentation. You will most commonly work in Normal view, where you can create, position, 
and format objects on each slide. In Normal view, you can also enter presentation text in the 
Outline tab or add speaker’s notes for each slide.

Explore the 
Normal View

Notes Pane
The Notes pane appears below the Slide pane. You can enter speaker notes 
associated with each individual slide into this pane. You can refer to these notes 
while presenting a slide show.
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chapter1Navigate 
PowerPoint Views

In addition to Normal view, you can use Slide Sorter view to 
organize slides, Notes Page view to create detailed speaker 
notes, and Slide Show view or Reading view to display your 
presentation.

Getting Started with PowerPoint Basics

StartStart

Home Insert Design Animations Slide Show Revie1.

Pictures of my Pets

2.

3.

4.

Two PuppiesTwo Puppies

Two CatsTwo Cats

Two TigersTwo Tigers

Pictures of my Pets
Pictures of my Pets

Reading View
Click Slide Show ( ) to present your show. Slides 
appear one at a time at full screen size. The Reading 
View ( ) is very similar to the Slide Show view, but 
gives you navigation flexibility. To exit either view, 
press .

Slide Sorter View
Click Slide Sorter ( ) for the best view to reorder 
slides, delete slides, or duplicate slides. In the Slide 
Sorter view, you can drag a slide to move it. If you 
double-click a slide, PowerPoint changes to Normal 
view and displays that slide in the Slide pane.

Navigation Buttons
Change views by clicking one of these status bar 
buttons: Normal ( ), Slide Sorter ( ), Slide Show 
( ), or Reading View ( ). You can also click icons 
on the View tab of the Ribbon to switch views, 
including Notes Page view.

Notes Page View
Display each slide and the associated speaker notes 
as a full page. You can move objects and type notes 
on the page. From the View tab, click Notes Page to 
work with this view.
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1 Click any tab on the Ribbon.

 In this example, Insert was clicked.

● The commands for the particular 
tab you clicked appear on the 
Ribbon.

2 Click the button or check box for 
any command.

 In this example, Clip Art Pane was 
clicked.

● The Clip Art task pane appears at 
the right. Use the task pane to 
finish executing the command, in 
this case, inserting clip art.

3 Click the down arrow ( ) next to 
any button to display a gallery.

 In this example, Layout was 
clicked.

Note: Clicking any button with a  displays a 
menu or gallery.

4 Click the desired choice from the 
gallery that appears.

Work with Ribbon Groups, Commands, and Galleries

You can find all the commands that you need to 
design and present your slide show on the 
Ribbon. Related commands are displayed on the 
Ribbon tabs. Commands are further arranged 
into groups with the group names shown at the 
bottom of the tab. Some command buttons 
include down arrows that display menus or 
galleries of commands when you click them.

Work with Ribbon Groups, 
Commands, and Galleries
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What happens if I click the 
main portion of a Ribbon 
button that has a down 
arrow on it?
If the sole purpose of the 
button is to open a gallery or 
menu, PowerPoint does that. If 
the main part of the button executes a 
command, either PowerPoint applies that 
command using the settings you last used or the 
most commonly used settings for that command.

How do I learn what a 
particular Ribbon button does?
Position the mouse pointer ( ) 
over the button and a ScreenTip 
describing the button appears. You 
see an enhanced ScreenTip that 
lists the button name, any available 
shortcut key, and a brief description of the button. By 
default, ScreenTip features are enabled, but can be 
turned off in the PowerPoint Options dialog box 
(described in Chapter 2).

● For some Ribbon commands, such 
as those on a contextual tab, you 
must first select an object on the 
slide before choosing a command.

5 Click the Dialog Box 
Launcher ( ).

Note: Any group with a Dialog Box Launcher 
( ) displays a dialog box when you click it.

 In this example, the Font dialog 
box appears.

6 Click OK to accept any selections 
you have made in the dialog box.

 The presentation reflects any 
changes you made.

Paste

ScreenTip
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2 Click a Ribbon tab.

● To display the Ribbon 
continuously again, click .

1 Click the Minimize the Ribbon 
button ( ).

 The Ribbon commands disappear 
from the top of the window, but 
the tabs remain visible.

Note: You can also press +  to hide the 
Ribbon.

Hide the Ribbon Commands

The Ribbon at the top of the PowerPoint application 
window is wide. You do not need to see the Ribbon 
commands at all times. You can hide the Ribbon 
commands, and then access them quickly when you 
need them. This enables you to see more of the slide 
that you are designing.

Hide the Ribbon 
Commands

 The Ribbon commands 
temporarily reappear, allowing 
you to click a command button.
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● The tab appears with KeyTips 
displayed for the commands.

Note: To hide the tab KeyTips, press . To 
hide all KeyTips, press  twice.

3 Press the shortcut key for the 
command you want to execute.

 In this example, press  +  
to display the Colors gallery.

 The command executes, or a 
menu, gallery, or dialog box 
appears so you can finish 
choosing commands.

1 Press .

● The KeyTips (shortcut keys) for 
the Ribbon tabs and Quick Access 
Toolbar appear in boxes beside 
the tabs and toolbar choices.

2 Press the shortcut key for the tab 
you want to use.

 In this example,  was pressed 
to display the Design tab.

Find and Use KeyTips

You may be more comfortable using your keyboard instead 
of your mouse. This may be particularly true if you use a 
notebook computer with a finicky touchpad. You can use 
the KeyTips feature to employ keyboard shortcuts to select 
and execute Ribbon commands.

Find and Use 
KeyTips
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1 Click the desired button on the 
Quick Access Toolbar.

 PowerPoint executes the 
command.

Note: Use any menu or dialog box that appears 
to finish executing the command.

● If you click the  beside the 
Undo button ( ), a menu 
appears with a list of actions 
to undo.

2 Click the Quick Access Toolbar 
 to access the menu.

● Note the check mark ( ) 
appearing next to commands 
on the Quick Access Toolbar.

● Click More Commands to see 
all available commands.

3 Click one of the commands from 
the menu list.

 In this example, Open was clicked.

● The selected command appears 
as an icon on the Quick Access 
Toolbar and a  appears next 
to it in the menu.

Using the Quick Access Toolbar

The Quick Access Toolbar appears above the File tab 
at the top of the PowerPoint application window. You 
can click buttons on the Quick Access Toolbar to 
execute the most commonly used commands quickly.

Using the Quick 
Access Toolbar
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Notes - 

3 Click the View tab.

4 Click Normal.

● The Notes pane reappears.

1 Position the mouse pointer ( ) 
over the pane divider until the 
mouse splitter pointer ( ) 
appears.

2 Click and drag downward until the 
pane disappears.

 The Notes pane disappears and 
the slide automatically fills the 
additional space in the Slide pane.

 If you click and drag upward, the 
Notes pane enlarges.

Resize the Notes Pane

You can enter speaker notes into the Notes pane. This 
area appears under the Slide pane in Normal view. You 
can show this area on your computer screen during a 
presentation. You can resize the Notes pane to make it 
easier to enter and read the notes.

Resize the 
Notes Pane
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PowerPoint  
Help

PowerPoint  
Help

 A window with a list of detail 
topics appears.

3 Click a detail topic.

 In this example, Create a photo 
album was clicked.

1 Click the Help button ( ).

 The PowerPoint Help window 
appears.

2 Click a main topic.

 In this example, Format slides 
or presentations was clicked.

Note: In some cases, after you click the main 
topic, a list of subcategories appears. Select the 
desired subcategory, and then continue to Step 3.

Using Help

Microsoft Office PowerPoint Help provides 
help from Microsoft Office Online or Help files 
installed on your computer if you have no 
Internet connection. You can find answers to 
your questions by browsing a Table of Contents 
or by searching using keywords.

Using 
Help
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Can I keep the Table of Contents visible while I am 
using Help?
Yes. Follow these steps:

1 Click the Show Table of Contents button ( )

2 Click a main topic to display a list of its topics.

3 Click a topic to display the help for that topic.

● The Help information appears in the right-hand pane and the 
Table of Contents remains visible.

● The previous help information 
reappears.

Note: After you click , the Forward button 
( ) becomes active. Click these buttons to 
browse Help.

5 Type a word or phrase.

 In this example, Insert text 
was typed.

6 Click Search.

● The search results appear.

 You can display a topic and 
browse using Steps 3 and 4.

7 Click the Close button ( ) to 
close the Help window when you 
finish using Help.

 The detail topic help appears.

● You can drag the scroll bar 
downward as needed to read 
more of the information.

4 Click the Back button ( ).
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